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Task 4 Analytical chemistry lab. I 

 

COULOMETRIC DETERMINATION OF ASCORBIC ACID  
 

Gabriela Broncová, Pavel Řezanka, Martin Kronďák and Tatiana V. Shishkanova  

 

Introduction 

Coulometry is an electroanalytic method where the determined compound is completely 

converted into another form in a different oxidation state at the electrode. Coulometric 

determination is based on the measurement of the charge requiredfor the completion 

of the reaction. The electrode reaction occurring at the working electrode has to proceed with 

100% yield. Other side reactions are not allowed, e.g. the decomposition of water can be a side 

reaction. Coulometric analysis can be performed with constant potential or constant current 

(coulometric titration). Coulometric titrations can be divided into two major groups – primary 

and secondary coulometric titrations. Primary titration is an analysis where the determined 

compound reacts directly at the electrode. Only a limited amount of compounds can 

electrochemically react (e.g. acids). In secondary coulometric titration the determined 

compound reacts with the titrant, which is generated by the electrochemical reaction 

at the electrode . The method is similar to classical volumetric titration, but the titrant is not 

added from a burette, but is generated at the electrode [1]. 

Faradays Law enables the calculation of the amount of the compound created 

at the electrode by electrochemical reaction: 

 

Q = I t = z n F 

 

where I is the generation current [A], t – the time required to reach the end point 

of the titration [s], z – the number of exchanged electrons in the electrochemical reaction,    n – 

amount of titrant, F –Faradays constant (F = 96 485.31 C mol-1). 

Then the mass of the compound can be calculated via the following equation: 

 

m = Q M / (z F) 

 

where m is the mass of the determined compound [g], M – the molecular weight 

of the compound being tested [g mol-1]. 

The end point of the titration can be determined visually or by tracking a physical quantity 

over time (potentiometry, amperometry, biamperometry, spectrophotometry, etc.). 

The advantage of coulometric titration is the possibility of using non-stable or volatile 

titrants (e.g. Mn3+, Br2), the titrants have not been standardized, and titration can be automatized 

easily. The time can be measured more precisely than volume; it is possible to reach lower 

detection limits than with classical titration (10 g – 100 mg) [1]. 

 

Biamperometric indication 

Biamperometric indication of the equivalence point (end of titration) is applicable where 

the titrant or the analyte forms a reversible redox couple. On the two same electrodes 

in the solution with dissolved redox system potential Er occurs. This potential is 

(with a reversible system) determined by the intercept of the polarisation curve 

with the potential axis (fig. 1A); for an irreversible system the intercept will be located between 
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the cathodic and anodic wave and its value will be controlled by the cathodic 
k

a  and anodic 

 a

a  overpotential (fig. 1B). 

 

 

 

 
 

 

Figure  1. Polarization curves of reversible (A) and irreversible (B) redox system. Er – 

equilibrium potential, E – inserted potential on the electrodes, Ik – cathodic, Ia – anodic,  

I – measured current, 
a

a  - anodic, 
k

a - cathodic overpotential. 

 

When the potential E (polarization potential) is applied to the electrodes from an external 

voltage source, the potentials of the electrodes are shifted and the current starts to pass through 

the electrode system. The concentration of the reduced (Red.) form of the compound will 

increase near the cathode and vice versa at the anode to reach equilibrium with the actual system 

voltage. The overall concentration change is zero. The value of the current I = Ia = -Ik is limited 

by the diffusion toward the electrode surface. 

With an irreversible system, the current cannot pass until the voltage is lower than the sum 

of the overvoltages: 
a

a   
k

a  = a  

The condition for the passage of current is the presence of both forms of the redox system. 

If the concentration of one form decreases, then the current also decreases. When only one form 

is present in the solution, then the current is almost zero. 

The shape of biamperometric curves (fig. 2) depends on the nature of the redox system. 

Close to equivalence point the current falls to zero*. This leads to the end of the titration being 

determined as the intercept of the decreasing (or increasing) part of calibration curve with 

the X-axis (I=0) or with the value of the residual current. 

The choice of polarization voltage is a critical factor in biamperometric indication. 

The optimal polarization voltage is usually in the range from 100 to 350 mV, its value should 

be determined experimentally. Too low a polarization voltage results in a very low indication 

current, which is difficult to measure due to electronic noise. On the other hand, too high 

a voltage can overtake the decomposition voltage and begins to induce side reactions 

at the indicator electrodes (e.g. decomposition of the supporting electrolyte). Electrode 

reactions will thus take place both at the generation electrodes (correctly) and also 

at the indicator electrodes (incorrectly). The result of the determination will be lower 

by the unknown amount that reacts at the indicator electrodes (shortened analysis time). 

 

                                                           
* This fact can be used to stop the generation of current at the equivalence point and stop 

the titration. This method is called „dead stop titration“. 
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Figure  2. Coulometric titration record with biamperometric indication where indication current 

(I) is plotted on Y axis and time (t) on X axis. Evaluation of the end of the titration (equivalence 

point) is marked with an arrow. Individual cases of coulometric titration: 

A: titration of reversible system (analyte) with reversible (titration agent)  a  E for both 

systems, 

B: titration of reversible system (analyte) with irreversible (titration agent)  a  of analyte is 

lower than voltage E applied to the electrodes, a  of titrant  E 

C: titration of the irreversible system (analyte) with reversible (titration agent)  a of analyte 

 E, a  of titrant  E. 

 

Technical equipment 

The coulometric system Unicoulo (“Nightfly systems s.r.o.” represented by Ing. Ivan 

Pavelka, CR) is designed for constant current coulometry with biamperometric, amperometric 

and potentiometric indication (Fig. 3). The device is newly implemented as a separate 

measuring unit (A) which is completely controlled by a computer program (B and C). 

The electrode system (D) is compatible with Metrohm equipment (Switzerland). 

 

 
 

Figure 3: Complete coulometry equipment: (measuring unit containing measuring card (A), 

computer (B), monitor (C) and electrochemical cell (D)). 
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The measuring unit (A) is now a separate box about 30x10x5 cm which communicates with 

the PC via a USB interface, and contains a control unit consisting of a new interface board, a 

measuring board, a power supply and a voltage and current source necessary for coulometric 

measurements, as well as indicator electrodes and a USB port to connect to your computer. 

The current source (1 mA and 10 mA) is located on the plug-in card. The current value 

differs for every single instrument and the right value, which has to be used for the calculation, 

is shown on the monitor of the computer (ask the teacher if you are unable to find it). This 

current is applied to the generation electrodes. If the current is unable to pass through the cell 

due to too high resistance, the indicator above IGen turns red. The most common reason is the 

absence of sodium sulphate solution in the space of the counter electrode or the electrode being 

disconnected from the instrument. The indication system is activated by applying the voltage 

to the indicator electrodes. The indication electrodes are mechanically connected to the same 

holder but they must not be in direct contact with each other. This can occur when insufficient 

care is taken when handling the cell*. 

The electrode system consists of a generation and indication cell. The generation cell 

consists of two flat platinum electrodes: a working electrode and a counter electrode. 

The counter electrode is separated from the solution by a porous glass frit to prevent the mixing 

of electrolysis products and side reactions. The tube is filled with 0.5 mol.l-1 sodium sulphate 

solution. The signal is recorded through two platinum indication electrodes, which are mounted 

in the same holder. The electrode set is placed into the titration vessel (fig. 4). The arrangement 

i) prevents the mixing of electrolysis products, ii) ensures that the electric field of the generation 

electrodes does not affect the indication system, iii) enables solution stirring to ensure the rapid 

response of the system [1]. 

 

 
 

 
 

Figure 4. Electrode system: 1 – working generation electrode (anode), 2 – counter 

generation electrode (cathode), 3 – indication electrode. 

 

                                                           
* Platinum is very soft material, which is easy to bend. 
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COULOMETRIC DETERMINATION OF ASCORBIC ACID 

(VITAMIN C) 

Tasks 

1. Determine the correct polarization potential for determining the level of ascorbic acid. 

2. Determine the level of impurities in the chemicals on the basis of the blank measurement. 

3. Determine the concentration of vitamin C in samples. 

4. Process the results according to the protocol. 

 

Principle  

Ascorbic acid is one of the first vitamins to be discovered. Its content in the fruit and 

vegetables decreases with storage and if we want to supply an organism with vitamin C, a more 

concentrated synthetic form has to be used. The recommended daily dose and average content 

in some meals is in supplement 1*. 

Your objective is to determine the content of ascorbic acid in industry vitamins 

by coulometric titration based on the oxidation of ascorbic acid by iodine. The scheme 

of oxidation is: 
 

OOH

OH

OH OH

O OOH

OH

O O

O+ I2 + 2HI

 
 

The titration agent is generated by the electrolysis of NaI at the working electrode (anode). 

 

The working electrode (anode): 2𝐼− ↔ 𝐼2 + 2𝑒− 

  

The counter electrode (cathode):   𝑁𝑎+ + 𝑒− ↔ 𝑁𝑎 

 2𝑁𝑎 + 2𝐻2𝑂 ↔ 2𝑁𝑎𝑂𝐻 + 𝐻2 

 

Its concentration is zero until the equivalence point is reached, and as a result there is no 

current in the indication circuit. The generated iodine (titration agent) is consumed by ascorbic 

acid (analyte) that is added to the titration vessel and behaves irreversibly, so the indicating 

system will show a practically zero current value up to the equivalence point. Beyond the 

equivalence point the indication current increases, because both iodine and iodide are present 

and the redox system I2/I
- is reversible. The solubility of iodine in the water is low, but in the 

presence of iodide the solubility is higher. The triiodide ion is created I3
- (red-brown colour, 

yellow in very dilute solution). 

The pH should be under 8, because in more alkali solution the iodine dissociates into 

hypoiodite or even iodate. In highly acidic solutions the HI can be oxidized to iodine 

by atmospheric oxygen. 
  

2𝐼2 + 𝑂𝐻− ↔  𝐻𝐼𝑂 + 𝐼− 

3𝐻𝐼𝑂 + 3𝑂𝐻− ↔ 𝐼𝑂3
− + 2𝐼− + 3𝐻2𝑂 

4𝐼− + 𝑂2 + 4𝐻+ ↔ 2𝐼2 + 2𝐻2𝑂 

                                                           
* Information from this supplement is NOT in the test and will be NOT assessed. 
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Ascorbic acid is not very stable, so the determination conditions are very important 

to prevent gross errors. Ascorbic acid decomposes when heated in the presence of oxygen, and 

this decomposition is catalyzed in the presence of some metals (e.g. copper). Ascorbic acid is 

stabilized by low pH, the presence of complexing agents and presence of reductans. A solution 

of oxalic acid is a good choice, since it maintains a low pH and also has a weak complexing 

ability. The use of a nitrogen atmosphere and short extraction time eliminates the influence of 

atmospheric oxygen. The influence of metals can be reduced by EDTA 

(ethylendiaminetetraacetate, complexon 3) or by using extraction into organic solvents. Never 

use a high temperature to increase extraction speed, because of the thermal instability 

of ascorbic acid [2]. Sometimes dilute hyperchloric acid [3], phosphoric acid with EDTA and 

sodium sulphite is used for the extraction [4]. 

In this exercise the pH of all samples is around 4, so no correction is necessary. Also 

commercially available pills do not contain iron or copper, so the addition of EDTA is not 

essential. 
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Working guide 

Agents 

 

Solution 

 

Application 

 

 

C 

[mol/l] 

Volume 

[ml] 

Na2SO4 Cathode space filling 0.5 * 

NaI Basic electrolyte 0.2 * 

Oxalic acid Basic electrolyte 0.5 * 

Ascorbic acid – standard solution For analysis 0.01 50 

Sample A  

(Vitamin C - powder) 

For analysis  50 

Sample B  

(Vitamin C - pill) 

For analysis  100 

Sample C 

(Lemon) 

For analysis  50 

* The solution is prepared in the laboratory 

Working with UniCoulo software 

Most of the functions are available via the drop menus, and their utilization is clear from their 

names. The interface follows the standards of MS Windows*. 

 

 Adjusting analysis parameters: Analyze > Parameters, or Setup > Parameters. First, you 

need to set three parameter windows according to the tables and figures in supplement 2 and 

3: 

1. Method/Mode, 

2. Parameters and 

3. Chart Setting. 

 

The most frequently used functions are: 

 Stirrer:  Monitor > stirrer on 

 Start of analysis:  Analyze > Start 

 Stirrer off:  Monitor > stirrer off 

 End of analysis:  Analyze > Stop 

 Store results in a file: File > Save As 

 Equivalence point determination: Process > Two Lines.  

 

1. Cleaning the electrodes 

The electrodes need to be cleaned for the electrode system to function correctly. Carry out 

electrode cleaning before the first measurement and after every measurement. Change 

the polarity of the working electrode from positive to negative (in the “Method” drop menu), 

change the reference current from 3 to 100 A (in the “Parameters” drop menu) and change 

the maximum of the Y-axis from 3 to 100 (list “Chart setting”).  

For the first cleaning (before the first measurement) run the analysis for 180s and stop it 

manually. For subsequent cleanings, run the analysis for 90s and stop it manually. 

                                                           
* See Computer sciences in the first and second semester. 
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2. Determination of polarization potential  

Each student will prepare his/her own standard of ascorbic acid with a concentration 

of 0.01 mol l-1 in the 50 ml volume flask by weighing out ascorbic acid (Mr=176.13 g/mol). 

Please be careful to work very precisely (weigh accurately into a small, clean and dry beaker 

(labelled standard)). 

 Put basic electrolyte into the titration vessel: 

 10 ml of NaI, 

 10 ml of oxalic acid (H2C2O4) and 

 H2O*. 

Then pipette exactly 1 ml 0.01 mol l-1 of ascorbic acid solution into the vessel. 

 Secure the vessel in the holder and drop the stirrer bar into the vessel. 

 Add the 0.5 mol l-1 Na2SO4 in to the cathode space. 

 Turn on the stirrer (Monitor > Stirrer on) and check that the mixer rotates continuously and 

does not jump in the vessel. 

 Set „Parameters“ (see. supplement 2). Perform the analysis (Analyze > Start) using 

polarization potential of 50, 100, 200, 300 and 600 mV. Measure each potential once. 

 Evaluate data using „Two Lines“ method. 

 Calculate the concentration of ascorbic acid (mol l-1) from the results (titration time, charge) 

and compare with the known concentration. 

Choose the optimal polarization potential and use it in all subsequent measurements. 

Save the measurement in the Data folder to your created folder according to the task 

measurement date, for example March 13, 2019 will have the name 0313_2019. The file name 

should contain the following: PN50, PN100, PN200, PN300, and PN600. E.g. analysis with 

300 mV potential will be saved to a file with the name PN300. 

 

 E.P. Equivalence point  

                                                           
* Use a cylinder the first time and mark the level using a felt-tip pen. 

E. P. 
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3. Blank 

The value of the blank provides information about the impurity content in chemicals. Mix 

the basic electrolyte (10 ml NaI a 10 ml oxalic acid and H2O) and measure the titration curve 

using the optimal polarization potential. Repeat it twice. The average will then be used. 

The file name will consist of the date and SL1 to 3. E.g. the 2nd analysis will be named SL2. 

 

 
 

4. Sample preparation 

 

  

 

 

Samples B 

Weigh the pill. Place it in the 100 ml beaker and add 30 ml of water. 

Wait until no more sample dissolves (the solution can be turbid, because 

the sample can contain a filler which is insoluble in water and does not react 

with iodine). Then transfer all of the solution into the 100-ml flask and add 

water to the mark. 

 

 

 

Sample C  

Slice the lemon into quarters and weigh one quarter on a watch glass. 

Squeeze juice from the lemon quarter. Filter the solution and transfer 

the extract to a 50-ml flask and add water to the mark. 

E. P .= 1 - 5 s 
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5. Sample analysis and data evaluation 

Samples A and B 

For the first measurement, pipette 1.0 ml of sample. For the 2nd to 5th measurements, pipette 

a volume of sample that will make the end of the titration approximately 200 seconds. File 

names should contain the name of the sample and the number of analysis, e.g. the 3rd analysis 

of sample B will be named SB3. Calculate the average (content of vitamin C per 100 g of 

sample), standard deviation and confidence intervals. 

Sample C  

Take 10 ml for the analysis, because the content of the vitamin is lower than the synthetic 

pills. Repeat it once. Only calculate the average in mg per 100 g of sample. 

 

 

6. Takeover and handover of laboratory working space 

Check the laboratory equipment according to the enclosed list. After finishing work: 

• clean the residue of crystallized Na2SO4 from the electrode holder, 

• immerse the electrode system in distilled water, drain and rinse the fritted tube with distilled 

water and fill with distilled water, 

• wash the dishes with detergent, and then rinse with water, 

• dry the metal parts, 

• dump, wash and wipe the weighing bottles dry. 
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Statistical evaluation 

Interval reliability: nstxL n /12,1   

Average: 
n

x
x

i
  

Standard deviation: 
)1(

)( 2






n

xx
s

i
 

Where n is the number of measured values and tn-1 is the critical value of Student’s distribution 

for an (n-1) degree of width and level of relevance  = 0.05. 

 

 

n-1 2 3 4 5 
t  4.30 3.18 2.78 2.57 
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Questions 

1. Describe the principle and conditions of coulometric titration. 

2. Write the equations of the electrochemical reactions at the generation electrodes. 

3. List 3 factors which affect the precision of coulometric titration. 

4. What is the role of the basic electrolyte in the determination of ascorbic acid by coulometric 

titration? 

5. Define the role of the generation and indication current in coulometric titration. 

6. Explain the principle of biamperometric indication of the equivalence point. Draw 

a theoretical titration curve for the following systems: 

a. C6H4(OH)2 (hydroquinone) + 2 Mn3+ → C6H4O2 (quinone) + 2 Mn2+ + 2 H+ 

b. I2 + 2Na2S2O3  2NaI + Na2S4O6 

c. blank 

Hint: 

a. Reversible redox systems are both analyte and titrant 

b. A reversible redox system is analyte only 

c. Reversible redox system is titrant only 

7. Explain the advantages and disadvantages of coulometric titration compared to volumetric 

titration. 

8. Write the name of the physical law used to calculate the content of the analyte 

in coulometric titration. 

9. How long is the blank analysis? 

10. How many ml of 0.01 mol/l ascorbic acid should be pipetted to obtain an equivalence point 

time of 200 s for coulometric titration with I2. Current 10 mA; Faraday constant = 

96485,31 C/mol. 

11. Write the indication methods used for coulometric titration. 

12. Draw the dependence of the generation current on time. 

13. What compounds are created at the generation electrodes, Pt-cathode and anode 

in anaqueous solution of NaCl? 
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Supplement 1 

Recommended daily dose of vitamin C: 

 

 Children Men Women 

Age 1-3 years 
4 - 8 

years 

9 - 13 

years 

14 - 18 

years 

Over 19 

years 

14 - 18 

years 

Over 19 

years 
Pregnant Nursing 

Vitamin C 15 mg 25 mg 45 mg 75 mg 90 mg 75 mg 90 mg 80-85 mg 115-120 mg 

 

Sources of vitamin C  

Vitamin content in some food ingredients (approximate values): 

 

Food ingredients Values of vitamin C content 

in mg 

Orange juice 200 ml  88  

Grapefruit juice 200 ml  70 

Orange  70 

Grapefruit  88 

Strawberry 200 ml  82 

Tomato  23 
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Supplement 2 

Setup > Parameters > Method/Mode  
W. E. Polarity Sensing  Generation  AZC Stirrer 

Negativea Amperometry Continuous  On  On  

Positivea Potenciometry  Constant Discontinuous Off  Off  

 pH measuring Controlled Discontinuous   
W.E. Polarity is the polarity of the positive generation electrode (iodine generation), 
a For cleaning the electrode system: Negative, for measurement/analysis: Positive. 

Setup > Parameters > Parameters 
Data acquisition timing (sec) Phase Wait 1 Generation Stabilization Measuring Wait 2 

(of basic measurement period) Duration sec 0.0 0.1 0.0 0.1 0.0 

Wait2 is the final parameter of the upper table, which includes the timing of the individual steps during the measurement. This parameter needs to be checked by clicking on the 

top table. 

I generation  Constants   Electrodes   Stirrer 

RPMx100 

Auto 1 mA 10 mA  Stoichiometric Ratio 1/1  U Polar mV *  8 

  Efficiency 1  Reference b 3  Direction 

  Molar Weight g/mol 176,13     left 

  No of Electrons 2     right 

  Faraday Constant C/mol 96485,31     On Start 

*Polarization potential U polar will be changed from 50 to 100 / 200 / 300 and 600 mV. Once you have determined and set the optimal value, you must not change it. 
b Reference - for cleaning the electrode system: 100 A; for measurement: 3A. 

Setup > Parameters > Chart Setting 
Chart Mode  Plot Mode   Points Style  Scrolling 

Y = f(t)  dots  .   

X = f(t)  dots+lines  x   

Y = f(X)    o   
 

Axes Setup and Titles Axe  Title Min Maxc Crosses Tick Marks 

 Y: Sensing I  -0.5 3 100 50 

 X: Charge Q mC     

 t: time t sec 0 300 100 50 
c For cleaning the electrode system- maximum Y:Sensing: 100; for measurement: 3. 
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Supplement 3 
Set method parameters in UniCloulo using the following path:  

Setup-Parameters. 
 

 
 

The following must be set in the first three windows: 

1. Method/Mode,  

2. Parameters and 

3. Chart Setting. 
 

 

 
Wait2 is the final parameter of the upper table, which includes the timing 

of the individual steps during measurement. This parameter needs to be checked 

by clicking on the top table. 

U Polar. [mV] (highlighted with a blue rectangle) is the polarization potential that you 

optimize while measuring the ascorbic acid standard.  
 

 
W.E. is the polarity of the positive generation electrode (iodine generation), 

positive polarity is selected during analysis and negative during electrode 

cleaning. 

 

 
In the table of values to set the graph of the analysis, ignore the middle line X Charge 

(do not delete anything). 



  New laboratory manual, January 2025, UCT Prague 

 

 

 16 

Extension of the laboratory task 4 

Voltammetric determination of ascorbic acid  

Gabriela Broncová, Sára Festová, Kristýna Havelková a Taťjana V. Šiškanova 
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Theoretical part  

Voltammetry  

Voltammetry is an electroanalytical method in which the current passing through an 

electrochemical cell is a function of the applied voltage. The electrochemical cell consists of 

three electrodes that are immersed in a supporting electrolyte. Supporting electrolyte is a 

solution containing inert salt and ensuring pH, the ionic strength, solubility analyte. The analyte 

is oxidized or reduced on the working electrode (WE) at determined potential that of which is 

set/controlled against the reference electrode (RE). The current as result of occurring redox 

reaction passes between the WE and the counter electrode (CE). The obtained dependence I vs. 

E is a voltammogram, from which qualitative and quantitative information about the analyte 

can be obtained.  

Voltammetric methods can also be used in the study of electrode processes. The relationship 

between current (I) and applied potential (E) obtained during voltametric measurements shows 

graph called voltammogram. Voltammogram gives both qualitative and quantitative 

information. The potential corresponding the increasing current with changes of concentration 

is qualitative characteristic. The current (peak height) that is linearly dependent on the analyte 

concentration is quantitative characteristic. 

 

Cyclic voltammetry  

Cyclic voltammetry (CV) is a kind of voltammetric technique showing current response as a 

function of a triangular potential waveform (Fig. 1) [1]. The rate of change of voltage over time 

is the scan rate (SR, V.s-1). The cycle can be divided into two parts: forward scan and reverse 

scan. In the forward scan, the potential is linearly increased from the initial potential to the 

vertex potential. In the reverse scan, the potential is decreased from the vertex potential to the 

final potential (Ep), which is usually the same as the initial potential. Depending on the 

requirements, one or more cycles can be used. The resultative graph is called cyclic 

voltammogram. 

 

Fig. 1: Dependence of the applied potential on time in cyclic voltammetry. 

 

The main advantage of CV technique is the studying of reversibility of the redox processes that 

can reversible, irreversible and quasi-reversible (Fig. 2). The characteristic peaks observed in 
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the cyclic voltammogram are result of the redox processes occurring in the diffusion layer 

formed near the electrode surface.  

  

 

Fig. 2: Cyclic voltammograms for reversible (black), quasi-reversible (red), and irreversible 

(blue) redox processes. 

 

In the case of reversible processes, the oxidation-reduction peaks are symmetric ones of the 

same intensity (Fig. 2, black). The potential difference between the cathodic and anodic peaks 

(∆Ep) can be used as a criterion for Nernstian behavior. For one-electron process, ∆Ep is 59 mV. 

In the case of reversible systems, it is observed a significant separation between the cathodic and 

anodic peak (Fig. 2, red). In the case of quasi-reversible processes, in which electrons are 

exchanged slowly, the individual peaks are less distinct and more distant from each other, and 

often one of the peaks is completely absent (Fig. 2, blue). 
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Practical part 

Apparatus  

A PalmSens4 potentiostat (PalmSens BV, Netherlands) with an electrochemical cell arranged 

in a three-electrode system (Fig. 3) is used for CV measurements. WE (red) is a glassy carbon 

(GC) electrode, RE (blue) is silver/silver chloride (Ag/AgCl (3 mol·L⁻¹ KCl)) and CE (black) 

is a platinum plate electrode (BVT Technologies, a.s. Strážek, Czech Republic). 

 

               

Fig. 3: PalmSens4 potentiostat used for CV measurements, including the electrochemical cell 

and individual electrodes.  

Chemicals:  

- ascorbic acid (AA) (analyte)  

- oxalic acid 0.03 mol·L⁻¹ (supporting electrolyte)  

- distilled water  

- alumina (polishing suspension)  

Electrode polishing  

Before starting the measurements, the surface of WE electrode (GC electrode) must be 

thoroughly cleaned. The cleaning restores the active surface of the electrode through removing 

adsorbed impurities. Fig. 4 demonstrates the procedure of mechanical cleaning. The surface of 

GC electrode (WE) is mechanically polished on a pad using alumina suspension. Polishing is 

performed in a figure-eight motion to minimize uneven wear of the electrode surface. 

  

Fig. 4: Schematic representation of procedure mechanical polishing surface of the working 

electrode [2].  
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After polishing, the surface of GC electrode should be thoroughly rinsed with distilled water 

and wiped dry with cellulose tissue. 

Preparation of solutions  

In this experiment, it is used the same standard AA solution (c= 0.01 mol·L⁻¹) (see part 

“Coulometry”). The supporting electrolyte (V=5 mL) is mixture of 0.3 mL of 5 mol·L⁻¹ oxalic 

acid and 4.7 mL of redistilled water. Use corresponding micropipettes for pipetting mentioned. 

 Instrument control and measurement parameter settings 

 Turn on the instrument (TEACHER) 

 Open the PSTrace program on the computer 

 Select the option "PalmSens 4" and Click “Connect”   

 Select "Technique", “Cyclic Voltammetry”  

 Select program mode "Analytical mode" 

 Specify parameters: 

Parametr Hodnota Jednotka 

t equilibration 5 s 

E begin 0.0 V 

E vertex 1 0.0 V 

E vertex 2 0.9 V 

E step 0.00244 V 

Scan rate 0.05 V/s 

Number of scans 1  

 

1. Pipette 5 mL of supporting electrolyte (0.3 mL of oxalic acid + 4.7 mL of distilled water 

with) into the cell. Measure the CV voltammogram (blank).  

2. Add 200 µL of effervescent tablet sample (identical for coulometry, prepared in a 100 

mL volumetric flask). Measure the CV voltammogram (Sample). Evaluate the anodic 

(oxidation) peak (its position and height).  

3. Add 100 µL of AA standard (identical for coulometry, prepared in a 50 mL volumetric 

flask) to the sample. Measure the CV voltammogram (Standard 1). Evaluate the anodic 

(oxidation) peak (its position and height).  

4. Then continue with three more additions (Standard 2, Standard 3 and Standard 4) and 

evaluate them (Fig. 5).  

 

After the measurement is completed, the electrodes must be mechanically cleaned again, 

rinsed with distilled water and wiped with cellulose tissue.  
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Fig. 5: Setting parameters for the measurement of an effervescent tablet sample using the 

standard addition method (left part), its subsequent measurement (middle) and data display and 

description (right).  

Then, select the corresponding icon, , where the evaluation of the 

concentration of the effervescent tablet sample using the standard addition method will be 

displayed in a table and a graph (Fig. 6). 

 

Fig. 6: Evaluation of data obtained from the measurement of an effervescent tablet sample using 

the standard addition method. 
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Based on the results obtained, compare both determination methods in terms of accuracy and 

speed of analysis. 

 

References 

[1] Wang J.: Analytical Electrochemistry. Wiley-VCH, US 2000. 

[2] Elgrishi N., Rountree K.J., McCarthy B.D., Rountree E.S., Eisenhart T.T., Dempsey J.L.: J. Chem. Educ. 2018, 

95, 197−206. DOI: 10.1021/acs.jchemed.7b00361 

 

Review questions for the test 

1. What is the principle of voltammetry? 

2. What is the name of the voltammogram obtained during voltammetric measurements? 

3. How many and what types of electrodes are used in voltammetry? Name each electrode. 

4. What are the functions of the individual electrodes used for? 

5. What is the principle of cyclic voltammetry? 

6. How can an irreversible system be recognized in a cyclic voltammogram? 

7. How can a reversible system be recognized in a cyclic voltammogram? 

8. What evaluation method is used to calculate the concentration of an analyte in a real sample? 

9. What parameters on a cyclic voltammogram are used for qualitative and quantitative 

analysis? 

 

 

 

 

 

 

 

 

 


